Installation and usage of GCC For Dummies Rev. G
(GCC+ Open OCD)

1. Run Olimex-GCCFD-20081015.EXE and follow the wizard steps. If you choose to install JRE then it
will start automatically during installation.
Here are pictures of the wizard steps during installation:
1) Here choose ,I Agree”

Olimex's ARM-JTAG-0CD GCC for Dummies Setup

O uma License Agreement

' Please review the license terms before installing Olimex's
www.olimex.com ARM-ITAG-0CD GCC For Dummiss,

Press Page Down to see the rest of the agreement,

This package contains the following software with it's respective licenses: S
- Java Runtime Envionment  hkbpe /v, sun, com

- Eclipse IDE kb f v eclipse. org

- Zvlin Embedded CDT hitkp: f v, 2vlin, comfembeddedcdt . html

- Cygwin kb e, cyguwin, org

- ‘Yagarto hitkp: f v, vagarto. de

- Codesourcery koolchain kb f v, codesourcery, com

- QpenCCD hitkp: vy, openocd, org

- demo projects and config files based on information from James P, Lynch, Martin

Thomas and Dominic F.ath, w

If ywou accept the terms of the agreement, click I Agree to continue, You must accept the
agreement ko inskall Olimex's ARM-ITAG-OCD GCC For Dummies,

I Agree I [ Zancel ]

2)Here choose , Next”

Olimex's ARM-JTAG-0CD GCC for, Dummies Setup

0 uma Chooze Components

' Choose which Features of Olimex's ARM-1TAG-0CD GCC for
www.olimex.com Durnmies you want ko install,

Check the components vou want toinskall and uncheck the components wou don't want ko
install. Click Mext ko continue.

Select components ko install: JRE werl.6.0_07 Deseription

Space required; 516,5ME

[ < Back, “ Mext = I [ Cancel
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3)Here the wizard propose you Destination Folder of your installation, choose ,Next”

Olimex's ARM-JTAG-OCD GCC for Dummies Setup =3
Ouma Choose Install Location
] Zhoose the Folder inwhich bo install Olimesx's ARM-ITAG-OCD
www.olimex.com i3 For Durnmies.

Setup will inskall Qlimesx's ARM-ITAG-0CD GCC For Dummies in the Following folder, Taoinstall in
a different folder, click Browse and select another Folder, Click Mext to continue,

Destination Folder

| | Browse, .,

Space required: 516,8MB
Space available: 4,156

< Back, ” Mexk = l [ Cancel

4) Here choose , Install”

Olimex's ARM-JTAG-0CD GCC for Dummies Setup Ali=l3

0 uma Start Installation

www.olimex.com

You are now ready toinstall Olimesx's ARM-ITAG-OCD GCC For Dummies files,
Press the Install button to begin the installation or the Back button ko reenter the installation
information,

< Back. ][ Install ] [ Cancel
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5) After installation completes - this window will pop-up - wait!
Olimex's ARM-JTAG-0CD GCC for Dummies Setup

0 L‘!me( Installing

] Flease wait while Olimex's ARM-1TAG-0C0 GCC Far Dummies is
www. olimex.com being installed.

Execute: cihgocfdijre-6u?-windows-iS586-p. exe

Windows Installer

A Preparing to install...
! T
LY

Cancel

Mullsoft Install Svskem w2, 39

< Back Mexk = Cancel

Starting Java setup - click on ,, View License Agreement...” and after reading it - close it and choose
LAccept”

i@ Java Setup - Welcome

X
Welcome to Java™

Java will make wour Internet experience richer,
whether vou are plaving games or music, getking
email an yaur mabile phone, checking oot a
webcam, learning about the universe, or anything
in between, Java can make it better,

[ Yiew License Agreement. ..

¥ou must accept the license agreement by clicking
the Accept bukbon bo download the product,

[ ] show advanced options panel L Dedine J [ Accept = J

After installation of Java completes, you click ,Next” on the following window:
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Olimex's ARM-JTAG-0CD GCC for Dummies Setup

0 um a Inztallation Complete
Setup was completed successfully.

www. olimex.com

Completed

Show details

On the next window which will appear you choose ,Close”. Now you have installed Eclipse on your
computer and may use it.
2. First time when you connect to the computer your programmer/debugger - ARM-USB-OCD or
ARM-USB-TINY, you will need to install drivers.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps you install software faor;

Qlimes Open0Ch JTAG Interface

{ } If your hardware came with an installation CD

*-?m‘:-'-’ or floppy dizk, inzert it now.

What do you vant the wizard bo do?

) Install the software automatically [Recommended)
(%) Inztall from a list or specific location [Advanced)

Click Mest to continue.

Mest » I[ Cancel

After you choose ,,Next”, on the window shown below, you should browse the directory of your
drivers.
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Found New Hardware Wizard

Pleaze choose your search and installation options.

(%) Search for the best driver in these locations.

I1ze the check boxes below ta limit or expand the default zearch, which includes local
pathz and removable media. The best driver found will be inztalled.

[ 1 5earch removable media [floppy, CO-ROM...]
[nzlude this lozation in the search:

| Ciigocfd ARM-USE-OCD-DRIVER v| | Browse

{3 Don't zearch. | will chooze the driver ta install

Chooze this option to select the device driver from a lizt. Windows does not guarantes that
the driver you chooze will be the best match for your hardware.

< Back ” Mest » ][ Cancel

Next”

[0 MeW nalawdareg dl [l

Please wait while the wizar

L] E The saftware wou are inztalling far thiz hardware:
L]
Qlimex OpendCh JTAG Interface

% Qlimex Opend CO

has not pazzed Windows Logao testing to verify its compatibili
with wWindows #P. [Tel me why thiz testing is imporkarnt. |

Continuing your installation of thiz software may impair
or destabihize the correct operation of pour spstem
Y either immediately or in the future. Microzoft strongly
,_j“/ recommends that you stop thiz installation now and
contact the hardware vendor for zoftware that has
pazsed Windows Logo testing.

Continue Snmway ] [ STOPR Inztallation l

< Back [ et » Cancel -

Here choose ,,Continue Anyway”
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished ingtaling the zoftware for:

% Qlimex Open0Ch JTAG Interface

Click. Finizh ta cloze the wizard.

When this window appears - choose finish and you are ready to use your programmer/debugger.

3. Run the shortcut "Eclipse" on desktop.
4. Open the project corresponding to the board you have and open its main.c file.

& CIC++ - Eclipse Platform
File Edt Refactor Mavigate Search Project Run  Window Help

[~ é - Rl g

F@| CfC++P B3 . B Navigato | = O

AN

[8] dernoz 1 D ettt
1T demoz10 Hew
T Ipc_2103
1T Ipc_hz10:
1T lpe_hz1z:
T Ipe_hz14i
7 Ipc_hzz1{ 3 Delste
1T lpc_hzzs

1T lpc_mt_2

1T lpc_mt_2

157 Ipe_pp1p] L2 Impart...
7 Ipe_p212{ 153 Export...

=| Copy

M- =N

=] Properties ffﬁ Debug \J;' Search

1T lpc_pz12;

1T Ipc2133

LT Ipe237s Run s 4
1T lpcez214 Debug As »
T lpe-l2294)  Team 3
L Ipe-p214g Caompare With 4
1T sam7ex2!

1T sam?hi2s!

{7 sam7p25  Properties Alt+Enter

7 stm_h103 T PO T CnsaE e
1T stm_p103 Mo consoles ko display at this time,

1T stm_p103_blink_flash
17 stm32fF103-stk

1T str_711

1T strex

L str7s0

demoz106_blink_flash
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& CIC++ - demo2106_blink_flash/main.c - Eclipse Platform

File Edit Refactor Mawigate Search Project Run Window  Help

G-Hal & i »

M@ cjc++P 52 . B5 MNavigate | — O

-

2 | B d><‘P ¥

=125 demaz106_blink_Flash ~

[l

i‘;? Binaties
[§] art.s
m Ipc210x.h
= @ main.c
 Lpczi0xh

PLOCK
Feed{void)
FIQ_Routinedvoid)
Initializefwvaoid)
IRGQ_Routine{vaid)
SWI_Routine(void)
UNDEF_Routinewvoid)
feed{vaid)
FIQ_Routinedvoid)
Initializefvaoid)
IRQ_Routine(void)
main{void)
SWI_Routing(void)
UMDEF_Routinedvoid)
a.out - [armyle]
b cre.o - [armfle]
b main.o - [armfle]
3&& main.aut - [arm)le]

B armusbocd_tiry.cfg

B armushbocd, cfg

= crklst

demoz106_blink_Flash,cmd

B Ipc2xcx_armusbocd_tiny.cfg
& Ipc2xxx_armusbocd. cfg
=| main.bin

eeeooeee T T %

= main.dmp
= main.map b

i3 0- Q- 40 (R R R Nr=0 A & [F@cic++ | #5Debug [H Java
) main.c 2 = 0|80 = =0
1l/1? o o o o o o o o o o o o o o o o o o o o o o o o o Y &g |l_ﬂz|}§ NS @ ~
Z Function declarations ; PLOCK
3 o o o o o o o ol o o o o o o 1“," .J LPCZ10: h
i
4 ++  feedivaid) : void
Svoid Initialize (void); @ Feed{void) : void
Groid feed(void); ++  FIQ_Raoutine(vai
7 ) _ . _ ] @  FIQ_Routinelvai
Svroid IRQD Routine (void) _ attribute  ({interrupt ("IRO"))): £t Initializfvoid) : +
Svoid FIQ Routine (void) _ attribute  {{interrupt("FIQ"))): . Initializ{void) : +
10void SWI_Routine (void) _ attribute  {{interrupt ("3IWI"))); i RO Routine(vloi
ilvoid UMDEF Routine (void) _ attribute | {interrupt ("UNDEF"))|: ® IRQiRoutine(voi
1z @ main{void) : ink
13,.fa-a-wa—xa—a—a—a—ra-xa—a—a—a—ra—xa—wa—a—wa—xa—a—wa—z-a—a—wa—wa—xa—a—a—xwa—xa—a—a—a—wa—xra—xa—wa— H Wl Routine(vni
14 Header files ®  SWI_Routine(voi
S e iy £+ UNDEF Rautine!
16#include "LPCZ10x.h" ® UNDEF_Routinel
17 h
15
19;’a-a-wa—xa—a—a—a—ra-xa—a—a—a—ra—xa—wa—a—wa—xa—a—wa—z-a—a—wa—wa—xa—a—a—xwa—xa—a—a—a—wa—xra—xa—wa—
z0 MALIN

|4

ERRE AR R AR R AR R R R R IR AR AR R TR R R AR R R R R

|~

B_\ Problems | & Console 52 = Properties %31 Debug {)n Search
Mo consoles to display at this time.

Writable Smart Insert 1 15 step b - Pairt

e

5. Build the project (Project->Build All).
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& CIC++ - demo2106_blink_flash/main.c - Eclipse Platform

File

|
Mg cjct+p 22

=3

Edit

Refactkar Mavigate Search [

YRR
rt“«:\T.Na\r'igato

@ B &£ @

125 demnoz106_blink_flash !
i‘;? Binaries

@ crt.s

IB lpczi0x.h

=] @ mair. c

[Ead

= LPC21meh
PLOCK

Build Configurations 3
EBuild Praject

Build Woarking Set 3
Clean...

Build Automatically

IMake Target 3

Properties

feed{vaid)
FI(_Routinedvoid)
Initialize{void)
IRQ_Routinevoid)
SWI_Routinedwvoid)
UMDEF_Routinewaid)
feed{void)
FIG_Routinevoid)
Initializedwoid)
IRQ_Routine{void)
maingvoid)
SWI_Routine(void)
UMDEF_Routinedoid)

eseecoeeee i

a.0ut - [arm/le]

crt.o - [arm/fle]

main.a - [arrmyfle]

‘?;f& main.out - [arm)le]

B armusbocd_tiny. cfg

armusbocd. cfg

crk st
demaZz106_blink_flash.crmd
lpc2:cx_armusbocd_tiny. cfig
lpc2acx_armusbocd. cfg

=\ main.bin

main., dmp

main.map

|4

[ Problems | B conscle 52

Mo consoles ta display at this time.

v
10void SWI_Routine (
llroid UNDEF Routine
1z

1| A F AT E R TR AR TRELLS
14

15 #FEXAETXEEXXAETXEESS

le#include "LPCEZ10x.
17
15
1O/ FHEE TR EERRR TR LTS
20

ERRE AT R LA I L LX)

CREEE -

R R R R R R R e ]

ction declarations
o o o o o o o o o tj

id):

roid) _ attribute | (interrupt ("IRQ"))]):

roid) _ attribute | (interrupt ("FIQ"))):

roid) _ attribute | (interrupt ("IWI"))):
(void) _ attribute  (({interrupt ("UNDEF"))]):

LR R T L]

Header files
R R R Ry

Br

R R R L R R R R A R L]

MALIN

R R R R R R R R R R AR R AR R N

= Properties %‘.@ Debug | 4 Search

Wrikable Smark Insert i1

=0

-

|

ﬁ|%|%§ Debug [ Java

EFox~ &0

@ AW e ¥
PLOCE
LPCZ10:.h
feed{void) : vaid
feed{void) : waid
FIQ_Routinevoin
FIQ_Routinevoi
Initializevoid) : «
Initialize(vaid) :
IR Routine{voi
IR Routine{voi
mainoid) : int
SWI_Routinewvai
SWI_Rautinelvai
UMDEF_R.outiner
UMDEF_R.outiner,

e TelTee T eolTeol e T EH

|

kS

6. Switch to the Debug Perspective(Window->Open Perspective->Debug).
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& CIC++ - demo2106_blink_flash/main.c - Eclipse Platform

File Edit Refactor Mawigate Search Project Run S8 Help

il sl g ids- 0 :ewgzdw SRR ime i@ A 5 [ cics | %5 mebug [ Javs
=) itor ———

£

%CIC++P 23 B5 Navigate | — O || [€] main.c

S0l fEe x> =0

4 ebug I
AN d)q; 9 = 1/% Show Yiew v éDTeamSynchmnizing FEEEREREEETREFFAAEA ~ £ |l_az|}:§ QS e ¥
=125 demoz106_blink_Flash ~ 2 ) ) # POk
ﬁ'? Binaries 3 3 1 Custaomize Per.spectlve... Other. .. EEFRERXAL TR ERNAL ) B =1 pcEioxh
|8 crt.s 4 Save Perspective As... +  feedivoid) : void
m Ipc210.h 5\!0:! Reset Perspedtive... ® Feedivoid) : void
= @ main.c Gvod Close Perspective ++  FIQ_Routine(vai
o LPC210wh 7| Close AllPerspectives _ ) ®  FIC_Routine{voi
# PLOCK Svod Naviaation , | —@ttribute {(interrupt("IRQ™))): £+ Initializefvoid) : +
£+ feedivoid) 9\!0:! = _attr:!.hut.e_ [ (:!.nt,errupt ("FIQ™) i) @ Initialize(void) :
¥+ FIQ_Routine(void) 00T ) iorking Sets » | _attribute ({linterrupt("3WI™ii}: £+ RQ_Routine(voi
T} Initializefvoid) 1ivoi Preferances d) _ attribute  (({interrupt ("UNDEF"))): @ TRQ Routine(vai
++ IRQ_Routine(void) 2 @ main(void) :int
N ) . 13/**w*x—a—*a—a—wa—x—z—z—z—z—wz—x—**z—*ta—x—a—a—*a—3—z—a—z—z—x*w*a—a—*xa—ta—a—****w*a—**x* - ) |
++ SWI_Routinewoid) ) +H SWI_Routinefvoi
++ UNDEF_Routine{void) L Header files ®  SWI_Routinevoi
. feed(void) 15 ﬂ‘ﬂ‘1‘ﬂ‘%‘ﬂ‘ﬂ‘**Tﬂ‘%‘ﬂ‘ﬂ‘ﬂ‘ﬂ‘Tﬂ‘%‘ﬂ‘ﬂ‘tﬂ‘1‘ﬂ‘%‘ﬂ‘ﬂ‘ﬁﬂ‘ﬁ‘ﬂ‘ﬁ‘ﬂ‘ﬂ‘ﬁ*#tﬁttﬁ*t*ﬁ**ﬁ*#*ﬁt*ﬁt; H UNDEF_RDutine(
® FIQ_Routine(void) to#include "LPCZ10x.h" ® UNDEF_Routine(
@ Initializevoid) 7
@ [RQ_Routinedwvoid) 1
® mainvoid) = 1O R AR R R R R R AR A AR AR TR R AR AR AR A AR AR TR AR AR T RAAAARTREFAAT
@ SWI_Routine(vaid) 20 HAIH v
PENEZEEEEIEEEEEE LA R E AR AR SRR A2 RSN —
@ LMNDEF_Routine]yoid) < I 3
b a.out - [armfle
b - [Earm,l’{e]] B_\ Problems | Bl Consale &2 = Properties #;? Debug | 4 Search i f~-=0
main.o - [armfle] Mo consoles ko display at this time.
:)t& main.aut - [armjle]
|ﬁ armusbocd_tiny.cfg
|.E] armusbocd.cfg
= crtlst
demaZz106_blink_flash.cmd
B lpc2xxx_armusbocd_tiny.cfg
B lpc2ix_armusbocd.cfg
= main.bin
= main.dmp
= main.map A
S | &

P e

Before doing the next operation your cursor should be in main.c window (click there with the
mouse).
7. Start OpenOCD program from Run -> External Tools -> OpenOCD or OpenOCDTiny .
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& Debug - demo2106_blink_flashimain.c - Eclipse Platform

File Edit Refactor Mavigate Search Project JEIGM Window Help

i NS R R N iz~ i®B - & @ cict+ |35 Debug | Java
ﬁ:Debug &3 ¢ «{9‘ 9= Yariables | &7 Expressions | ®a Breakpoints 532 =8
® % & = =1
s, Skip All Breakpoints @ Cilgocfdiprojectstdemo2 106 _blink_lashimain.c [ine: 33]
&Remove All Breakpoints @ Ciigecfdiprojectsidemo2106_blink_flashimain, o [ine: 38]

& Chacddiprajectsidemaz 106_biink_Flashimain,out

main.c £ =8 EE Outline Disassembly &2 =8
1/"* FEEEE LT T T TR ANNFTTNSNNNS LI
2 Function ded =
3 FEEE R T AT AATATALANTENNS
4
Swoid Initialize (void):
froid feed(void): T Use Step Fikers Shift+F5
7 w
¢ @, Run Chr4F11 b
E %, Debug F11 -
El canscle 52 E Properties Q" Search % a |_'<j -~ =0
Mo consoles to display at this time, Run History ’
Run As 3

Run Configurations. ..

Debug Histary 3
Debug As 3
Debug Configurations...

J Q1 openoD
o D Timy
(3, 3 OpenaCD For 5TM32 s

G, 4 OpenoCD STR7 Pragram
(3, 5 Open((D STR7 Erase

Run As 4
External Tools Configurations...
Organize Favorites. .

If your cursor is not there for next operation you will receive Error message:

& Problem Occurred

‘Launching DpenaCD Tiny' has encountered a
problem.

Yariable references empty selection: ${project_lock

ok || petais >

If everything is correct you shoul see this window:
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& Debug -

demo2106_blink_flash/main.c - Eclipse Platform

ol Chgecfdiopenocdibintopenocd-frdzxe, exe

@ Cigocfdiprojectsidemoz 106_blink_flashimain.c [line: 33]
@ Cgocfdiprojectsidemoz 106_blink_flashimain.c [line: 38]
& C\geefdiprojectsidemoz 106 _blink_Flashmain. out

(€] main.c &3 =0 EE Outline Disassembly 3

]_I/ﬂ‘ A T T T T T T A AT T AT AT AR AT AT AAATASTAFTASTIAAASTIAFAASTINFANTNT A

Z Function declarations n

R R T e

ki

Svoid Initialize (void):

tvoid feed(void) ;

7 .

< |

E console 52 =1 Properties | 4" Search |§|I@| =
OpenXCD Tiny [Program] C:igecfdyopenocdibin|openocd-frdz:c:. exe
Open On-Chip Debugoger 1.0 (2005-10-04-10:00) svn:exported
$TREL: http://svn.berlios.de/svnroot/repos/openocd/ trunk/src/openocd. e §
Info: options.c:50 configuration output_handleri): jtag speed: 3, 3
Info: options.c:50 configuration output handler(): Open On-Chip Debugger 1.0 (2005-10-04-10:00) svn:exported
Info: Jtag.c:1389 jtag examine chain(): JTAG device found: Ox4f1f0f0f (Manufacturer: Ox787, Part: Oxf1f0, Version:
Info: Jtag.c:1389 jtag exsmwine chain(): JTAG device found: Ox4f1f0£0f (Manufacturer: Ox787, Part: Oxf1f0, Version:

Writable Smart Insert 101

Dx4)
0x4)

File Edit Refactor Mavigate Search Project Run ‘Wwindow Help

SRR S MU R ] RRR RSN G i@ A £ ECICH+ (35 Debug | [ Java
%5 Debug 2 o i2 3@ Y 7 O |[69= variables | 85 Expressions | ®g Breakpaints 52 = O
=] % OpenQCD Tiny [Program] & & o w =] |§| =

o

8. Start the debugger from "Run-> Debug Configurations->Embedded Debug(Cygwin)-><your prject
debug profile>", "Debug"

& Debug - demo2106_blink_ram/main.c - Eclipse Platform

File Edt Refactor Mavigate Search Project BEUGE Window Help
=4 - =N :’?ﬁ" -Q- % . © Toggle Breakpoint Ctrl+Shift+E i(B- @D - s % Cich+ H&‘ Debug | 0 Java
7 @ Toggle Line Breakpaint e =5
5 = : [ B 1010 .
3@51 Debug &2 B @ Toggle Method Breakpoint 0= Yariables |95 Expressions | ®e Breakpaints 2 il Registers _
ER OpenCCD Tiny [Programm] 6, Taggle Wakchpoirt R 8 | W = |§| -
vl Clgecfdiopenacdibiniopenacd-frdz.c:, ", Skip Al Breakpoints & CHProjecks\Open0CD_CDYworkspace-srcidemo2106_blink_ramimain.c [Funckion: main]
- . ) ) - )
SﬁRgman all Breakpoinks @ Ciigocfdiprojects|demoz 106 _blink_ramimain, o [Function: main]
g C:iProjectsiOpenOCD_CDWworkspace-sroidemo2 106_blink_ramimain.c [Function: main]
g C:\Projects\OpencCD_CDlworkspace-sroidemo2106_blink_ramimain.c [Function: main]
8 C:ProjectsiOpenoCh_CO\workspace-srodernoz 106_blink_ramimain.c [Function: main]
& C\gocfdiprojects\demoz 106 _blink_ram'main,c [Function: main]
(] main.c 3 =g EE Qutline Disassembly &8 =0
42 JOCLR = 0OxO ~
43 for (1 = 0;
44 IOSET = 0OxC
45 for (j = 0;
46 H =
47 ' T Use Step Filters Shift-+FS
48}
43 @, run Crr+FLL
50 %, Debug Fi1
51 -
D2/ s h s s SR SR TRERERENENERN AN A Run History 4
53 Initi Run As '
CAGE R R T FH TR EEFF AR TR TR A FH B Run Configurations. .. b
— Debug History L = ==
B console i2 = properties | 47 Search | [ Debug As 4 Ex BH |EIE| o E-rj-=0H
Open0CD Tiny [Program] C:gecfdiopenocdibintope Debug Configurations. ..
SUEL: http://svn.berlios.de/svnl %E . | Tool R pocd.o § Rl
Info: options.c:50 configurad - HEna Eos — 3,03
Info: options.c:50 configuration output_handler(): Open On-Chip Debugger 1.0 (2005-10-04-10:00) svn:exported
Info: Jtag.c:1389 jtay exswine chain(): JTLG device found: Ox4flf0f0f (Manufacturer: Ox787, Part: Oxflf0, Version: Ox4)
Info: jtag.c:1389 jtag examine chaini): JTAG device found: 0x4£1f0f0f (Manufacturer: Ox787, Part: Oxf£1f0, Version: 0Oxd)
User: target.c:436 target process_reset () : Timed out waiting for halt after reset
b
Writable Smart Insert 4706 e
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File Edit Refactg

ﬁDebug Py :

= @ OpencD
..... .ﬁ Cihac

The following window will appear:

clipse Platform

Create, manage, and run configurations

ELICES

|type filter text

f E CJC++ Attach to Local Application
E CJC++ Local Application
-[&] CfC++ Postmartem debugger

Zvlin Embedded debug {Cyawin)

G Zylin Embedded debug (Mative)
Zvlin ZPU simulator debugger (Cygwin)

main.c X

4z

43

44

45

46

47 i

48}

49

50

51

Bz wwwwt )

53

CaA®®&FHTH

<

& console 2
Open0CD Tiny [Prg
SURL: http:
Info: opt
Info: op
Info: jtc
Info: jt
User: ta

Filter matched & of 39 items

MName: | Inc2106_ram

Main % Debuggerw 7] Commands} T%y Source | ) Commoﬂ

Project (optional):

| dermaz106_blink_ram | [ Browse. ..

C/C++ Application:

| main, ouk | [Search Projeck. .. ] [ Browse, .

[ application console

Apply Rewert

@

| Writable | Smart Insert | 476 22 step.brp - Paint

Here you choose your project and click on ,, Debug”.
After that that you should see window like this:
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& Debug - demo2106_blink_ram/main.c - Eclipse Platform

File Edit Refactor Mawigate Search Project Run Window  Help

iR @ @ -0 Q- 4 H e AR Nr=g & EEcict+ | 35 pebug | Java
ﬁDebug Py O o = = = B |69 variables | 87 Expressions | ®a Breakpaints 12 198 Reaisters =0
=G, OpenoCD Tiry [Program] S& w | EE |§>| =

B Chaecfdiopenocdibiniopenocd-frdzi . exe
=3¢ Ipc2106_ram [Zylin Embedded debug {Cygwin)]
= Embedded GDE (03-11-11 13:15) (Suspended)
[=h-g® Thread [0] (Suspended)
= 1 main{} Crigecfdiprojectsidemaz 1 06_blink_ramimain.c:28 0x400002a8
B arm-elf-gdb.esxe (09-11-11 13:15)

,é' Cigecfdiprojectsidemoz 106_blink_ramimain. c [Function: main] ~
& Ci\Projects\Open0CD_CDiworkspace-sreidemoz106_blink_ram'main.c [Function: main]
ﬁ C\Projects\0Open0CD_CD\warkspace-srctdemo2 106_blink _ramimain.c [Funckion: main]
,E; CH\Projects\OpenCCD_CD\warkspace-srcldemo2106_blink_ramimain.c [Funckion: main]
ﬁ Cihgecfdiprojectsidemoz 106_blink_ram'main. c [Function: main]

ﬁ Chgecfdiprojectsidemo? 106_blink_ramimain.c [Function: main]

,é' C:igecfdiprojectsidemoz 106 _blink_ramimain. c [Function: main]

v
(] main.c 3 =g EE Qutline Disassembly &8 =0
int 3j: f4 loop QSDXQDDDDZBB <waintls>: bl O0x4000036c <Initialize:> A
0x400002ac <maint20>: mov r2, #-536870904 ; Oxe0O0C
/¢ Initialize the system 0x400002b0 <main+24>: add rz, rz, #163540 ; 0Ox2500
Initimlize(): 0x400002b4 <main+Z8>: mov r3, #-536870904 ; Oxe0OC
0x400002k& <main+32»: add r3, r3, #163540 : OxZ80C
/¢ =set ig pins for led PO.7 0x400002be <main+36>: ldr r3, [r3]
IODIR |= Ox00000080; /¢ pin PO.7 is an output, everyt 0x400002c0 <main+40>: orr r3, r3, H1Z§ ; OxS80
IO3IET = 0x00000080; /f led off 0x400002c4 <main+dd>: str r3, [ri]
IOCLE = 0x00000030; /4 led on 0x400002c8 <main+48>: mov r3, #-536870908 ; Oxe00C
O0x400002ce <main+52>: add r3, r3, #163540 ; Ox280C
/¢ endless loop to toggle the red LED PO.7 0x400002d0 <main+S56>: mov r2, #1268 ; 0x80
while (1) 0x400002d4 <maint+60>: str r2, [r3]
r > w MNurdfnnn? A2 Awad nlfds . vamTr w2 #_C2ea7nann - nv=nnrv
B conscle 52 = Properties | 7 Search | [ Memory | = Modules ® UEH’EI'@' =y L et B-r3-=0
|pc2106_ram [Zvlin Embedded debug (Cygwin)] arm-elf-gdb. exe {09-11-11 13:15)
28 Initialize(): R
mi_cmd var create: unable to create varishle ohject
wmi_cmd Var_create: unable to create variahle object
mi cmwd wvar create: unable to create varisble object
mi_cwmd wvar create: unable to create varisble object
mi_cwmd disassemble: Invalid filensme.
v
Writable Smart Insert | 25: 1 P o*

9. Enjoy the demo.

Note: This release includes experimental support for installation directory selection. Please use
standard paths without spaces, or better yet leave the default one.

Note: Separate installations of OpenOCD, Yagarto and Codesourcery toolchain may interfere with
this package. We recommend to uninstall them.

Note: If at any point a message box pops-up stating that ${project_loc} is not defined, make sure that
a file from the project is actually open and selected in the editor.

Note: STM32 projects require revision 555 of OpenOCD which is registered as the external tool
"OpenOCD for STM32".

Note: For STR7xx chips we recommend the following flash debug procedure:

1. Prepare debugging by switching to Debug view and loading main.c in the editor.
2. Run the external tool "OpenOCD STR7 Program" and wait for it to finish.

3. Power cycle the target board.

4. Run the "OpenOCD" external tool.

5. Run the project debug configuration to start debugging.

The example here is made for ARM-USB-TINY and LPC-P2106, if you have ARM-USB-OCD - on step 7 you
should choose OpenOCD.
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